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第一节 建立 Die 封装 

在这一章节，你将使用 Die Wizard 向导定义一个 die 元件的参数结构。你也可以学到如

何从 text 文件导入 die 焊盘数据以及修改导入的数据。 

本节将学习： 

y 输入 die 参数数据 

y 从 ASCII 文本文件导入 die 数据 

y 修改导入的 die 数据 

y 增加 die 到设计中 

y 了解 ASCII 文本文件格式 

 

在本节中我们将使用 Start-up 文件来设置所要求的参数。 

打开 start up 文件 
 

菜单 File  > New 

使用 Start-up 文件: 

1. 在 Set Start-up File 对话框中，选择 PBGAtutorial.stp。 

提示：如果 Set Start-up File 对话框没有出现，在 File 菜单中选择 Set Start-up 
File 进入选择。或者将对话框中的 Don’t display again 选项勾去除，下次新建文件

时将显示此对话框。 

 
2. 点击 OK 按钮。  
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输入 die 数据参数 
 

工具条 BGA 按钮  > Die Wizard 按钮   

如果没有类似 GDSII 或者 ASCII 格式的电子数据，你可以使用参数结构去构造一个 die
元件的定义。 

 
Die Wizard 提供了一个根据你输入的参数实时动态更新的预览窗口。 

定义 die 外形 

定义 die 的外形尺寸： 

1. 在 Create Die dialog 对话框中，点击 Parametrically 图标按钮。 

2. 在 Die Wizard - Create Parametrically 对话框中，点击 Die Size 表格。 
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3. 在单位 Units 选项中选择 Metric 

4. 在 Die Part Type 框中，输入名字 DIE248 

5. 在 Length 框中，输入 die 的长度值： 8 mm 

6. 在 Width 框中，输入 die 的宽度值： 8 mm 

定义 CBP （chip bond pads） 
Die Wizard – Create Parametrically 对话框 > CBP 表格 

定义 pads: 

1. 在 Total 框中，输入 248，指定总共的 pad 数量为 248 个 

2. 确保 GND % and PWR % 设置为 10，这个说明每边有 10％的 pads 做为 GND 和 
PWR 

3. 在 Pad Pitch 框中，输入 .12 指定 pad 间距为 0.12 mm 

4. 在 Distance from Die Edge 框中，输入 .1 

5. 在 Pad Shape 区域，在 Shape 列表中选择 Rectangle 

6. 在 Length 框中，输入 .07 指定 pad 长度为 0.07 mm 

7. 在 Width 框中，输入 .07 指定 pad 宽度为 0.07 mm 

 
提示：可以通过修改 spreadsheet 中任何单元的 total pad、GND、或者 PWR 的 pad
数量。 

    定义 pad 数量 
Die Wizard – Create Parametrically 对话框 > Pad # 表格 
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定义 pad 数量： 

y 在 Pad 1 区域，选择 Top 和 Left 将 pin1 定义到左上角。 

 

定义 pad  function 名称 
Die Wizard – Create Parametrically 对话框 > Pad Functions 表格 

定义 pad function 名称: 

y 虽然本表格内容不需要修改，请浏览查看各 pad 列表的功能名称 

提示： 可以选择任何一个单元修改其功能名称。 
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定义 die wizard preferences 
Die Wizard – Create Parametrically 对话框 > Die Prefs 表格 

定义 die wizard preferences: 

1. 在 Part Creation Mode 区域，点击 Add Part to Design，这将自动添加 die 元件

到设计中。 

2. 这样你就完成了 die 元件的定义。为了练习的目的，请点击 Cancel 按钮，因为你需

要进入下面的导入 ASCII 文件过程的学习。如果你点击了 OK 按钮，将自动地将此

元件添加到设计中。 

 

从 ASCII 文本文件导入 die 数据 
 

Die Wizard 按钮   

导入数据: 

1. 在 Create Die 对话框中，点击 From Text File 图标按钮，选择从 ASCII 文本文件

导入 die 数据。 

3. 在 Die Wizard - Create from Text File 对话框中，点击 Browse 按钮。 
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4. 在安装目录 \PADS Projects\Samples 下查找并选择 Die248.csv 文件。 

 
4. 点击 打开 按钮，将文件内容导入到 Die Wizard。 

结果：预览窗口将显示导入的 die 数据。 
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修改导入的 die 数据 
 

Die Wizard – Create from Text File 对话框  > Die Size 表格 

一旦你导入的 die 数据到 Die Wizard，你就可以编辑修改需要的数据：die outline、
origin、pad numbering、pad size、pad shape 以及 pad function 名称。 

默认的 die outline 是一个围绕于 die pads 周围的方框，一般需要对其修改。 

更改 die outline: 

1. 确认在 Units 区域选择的单位是：Metric 

2. 在 Length 框中，输入 8 用于指定 die 的长度为 8 mm 

3. 在 Width 框中，输入 8 用于指定 die 的宽度为 8 mm 

增加 die 到设计中 
 

Die Wizard – Create from Text File 对话框  > Die Prefs 表格 

增加 die 元件到设计中： 

1. 在 Part Creation Mode 区域，点击 Add Part to Design。当你关闭此对话框时，

将自动增加此 die 元件到设计中。 

2. 点击 OK 按钮。 

 
3. 在标准的工具条上，点击 Board 按钮重新调整窗口视图的大小。 

了解 ASCII 文件格式 
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在上面的练习中，我们导入了一个 ASCII 文本文件到 Die Wizard 中，开始了 Die 元件

的定义。这些数据可能来自 IC place 和布线设计系统，电子数据表格类似于 Microsoft® 
Excel 或者一个文本编辑器。 

文件格式 

文件的第一行必须自动所用的单位，可以接受的单位是：Mil、MM、Micron 和 Inch，
这些单位不区分大小写字母。 

导入 Die Wizard 的 Pad 数据必须是以下的格式，各个数值之间必须使用逗号分割开。 

Pad 数据格式: 

Pad# Pad Function Xcoord Ycoord Pad Length Pad Width 

1 GND -3.66 3.865 0.07 0.07 

2 PWR -3.54 3.865 0.07 0.07 

3 SIG003 -3.42 3.865 0.07 0.07 

Pad 数据说明: 

数据 说明 

Pad# chip bond pad 号码 

Pad Function pad 功能名称 

Xcoord 从 Die 的原点算的 X 轴距离 

Ycoord 从 Die 的原点算的 Y 轴距离 

Pad Length (可选) die bond pad 的长度值，如果没有指定默认为 1 

Pad Width (可选) die bond pad 的宽度值，如果没有指定默认为 1。如果

Pad Length 指定了，但是 Pad Width 没有指定，pad 将默认为

圆形。 

文件格式实例： 

MM,,,,, 
1,GND,-3.66, 3.865, 0.07, 0.07 
2,PWR,-3.54, 3.865, 0.07, 0.07 
3,SIG003,-3.42, 3.865, 0.07, 0.07 
4,SIG004,-3.3, 3.865, 0.07, 0.07 
5,SIG005,-3.18, 3.865, 0.07, 0.07 
 

y 不要保存此设计文件。 
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第二节 建立 BGA 模板 

在这个课程中，你将学习如何建立一个 BGA（ball grid array）并添加到设计中。 

在 PADS Layout 中，元件的封装被称为 PCB decals，为建立一个 BGA，你必须使用

Decal Editor 建立一个模板做为 PCB Decal，并建立一个 Part type，然后将 BGA 
decal 指派给 part type。 

本节将学习: 

y 建立一个 BGA decal 

y 保存 decal 

y 添加 BGA 元件到设计中 

 

要求：进入本节学习之前，你必须理解 PADS Layout 库元件的概念。 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_1.pcb 文件。 

建立 BGA decal 
 

Decal Editor 提供了一个 BGA Pin Wizard，在这里，你可以输入指定的 BGA 参数而后

自动建立一个 BGA 封装。在本节学习中，你将建立一个 23 排×23 列，1.27mm 脚间

距、0.75mm 焊盘球的 BGA 封装。 

使用 BGA pin wizard 

菜单 Tools > Decal Editor > Drafting 按钮   > Wizard 按钮   

使用 Pin Wizards 对话框建立复杂的焊盘阵列模块。 

建立 BGA 封装: 

1. 在 Pin Wizards 对话框中，选择 BGA/PGA 表格； 

2. 在 Units 区域，选择 Metric； 

3. 在 Origin 区域，选择 Center； 

4. 在 Decal Type 区域，选择 Substrate；出现提示信息 Substrate Decal Type 
selected, terminal numbering will be mirrored appears. 点击 OK； 

5. 在 Silk Screen 区域，清除选项 Create； 
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6. 在 Pad Stack 区域，选择 SMD； 

7. 在 Diameter 框中，输入 .75； 

8. 选择 Assign JEDEC Pinning； 

9. 在 Row Pitch 和 Column Pitch 框中，输入 1.27； 

10. 在 Row Count 和 Column Count 框中，输入 23； 

11. 在 Void Rows 和 Void Columns 框中，输入 15； 

12. 在 Center Rows 和 Center Columns 框中，输入 5； 

13. 点击 OK 按钮，PCB Decal 就建立完成并显示于工作界面上。 

 

Substrate 或者 component decal 类型 

当建立了一个元件（将贴装于 PCB 表面的 BGA）的 BGA 模板，你建立的 BGA 的 A1
管脚位于模板的左上角。可是，当你建立一个 BGA 模板添加到 BGA substrate 的设计

中时，你旋转了 decal 的管脚 A1 在模板的右上角，因为 BGA 模板被镜像了一下放置于

设计的底层，所以最终的 BGA 模板管脚 A1 将会位于左上角。 

保存 decal 
 

File > Save Decal 

添加 BGA 到你的设计之前，请保存 decal 并建立一个 part type。在 PADS Layout
中，这两个步骤被合并到一个单一的操作中。 
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保存 decal 到库中: 

1. 在 Save PCB Decal to Library 对话框中，在 Library 下拉列表中，选择  
\2007PADS\SDD_HOME\Libraries\usr 

2. 在 Name of PCB Decal 框中，输入 BGA329 

 
3. 在弹出的 Would you like to Create New Part Type？对话框中，点击 Yes。 

 
4. 在弹出的 Part Information for Part – Unnamed 对话框中，点击 OK 按钮。 

 
5. 在 Save Part Type to Library 对话框的 Library 列表中，选择

\2007PADS\SDD_HOME\Libraries\usr 

6.  在 Name of Part Type 框中，输入 BGA329 
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7. 点击 OK 关闭对话框并保存 part type。 

8. 在菜单 File 下，选择 Exit Decal Editor 退出 Decal Editor 并返回到 Layout 
Editor 界面。 

添加 BGA 元件到设计 
 

BGA 按钮   > Add Component 按钮   

现在你可以添加 BGA 元件到设计并将其放置于 Bottom 层。  

添加 BGA 元件: 

1. 在 Get Part Type from Library 对话框中，在 Items 框中，输入 bga* 并点击按钮 
Apply，为缩小搜索范围，将搜索库限制于 usr 库。 

结果: 预览:BGA329 元件显示于 Part Types 列表中。 

 
2. 选择 usr:BGA329 并点击 Add 按钮，将添加此 part type 到设计中。  

结果: 一个对话框将出现提示你输入添加元件的前缀，这是元件参考标号的前缀（例

如：电阻 R，电容 C）。 
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3. 输入 BGA 在对话框中并点击 OK  

结果: 一个 part type BGA329 ，参考标号为 BGA1 的元件将黏附于鼠标指针上。 

4. 在 Get Part Type from Library 对话框中点击 Close 关闭对话框。 

5. 为了将 BGA 焊盘放置于 BGA substrate 的底层，点击鼠标右键并选择 Flip Side，
这将镜像此元件并将其放置于设计的底层 bottom。 

 
6. 移动鼠标到设计的原点标志上，点击鼠标左键，放置元件于设计的原点上。 

提示: 你也可以使用搜索无模命令放置元件，输入 s 0 0，然后按回车键，再按空格

键。 

7.  在标准工具条中，点击 Board 图标按钮调整窗口视图。 

 
8. 不需要保存此设计。 
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第三节 建立封装的 Substrate 

建立高级封装的下一步是建立一个 substrate 的外框线，也就是板框。 

本节将学习: 

y 建立板外框 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_2.pcb 文件。 

建立板外框 
 

Drafting 按钮   > Board Outline and Cut Out 按钮   

板外框的建立方法类似于多边形的建立。 

1. 输入无模命令 g1 并按回车键，设置格点为 1 mm。 

结果: 状态栏上显示格点设置为 1 1 。 

2. 输入无模命令 gd1 并按回车键设置显示格点为 1。  

结果: 显示格点现在显示为每 1mm 显示一个小点。  

提示: 你可能需要调整显示比例才可以看到格点。 

3. 点击鼠标右键选择 Rectangle。 

4. 移动鼠标指针到坐标 -15,-15 并点击鼠标左键，你也可以通过搜索无模命令，输入 s 
-15 -15 并按回车键，一个动态的矩形框黏附于鼠标上。 

5. 再移动鼠标指针到坐标 15, 15 并点击鼠标左键完成板外框建立。同样你也可以使用

无模命令。 

6. 在标准工具条中，点击 Board 按钮调整浏览的视图大小。 

 
7. 不要保存此设计文件。 
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第四节 定义层和设计规则 

设计规则包括 clearance、routing 和高速设计约束规则以及针对 nets、layers、class 
groups、或者 pin pairs。你也可以指定条件规则和差分线规则。  

本节将学习: 

y 针对 BGA substrate 设置叠层的安排 

y 设置叠层结构 

y 修改默认的过孔参数 

y 设置默认的安全间距规则 

y 使用在线设计规则检查（DRC） 

y 设置显示颜色 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_3.pcb 文件。 

设置叠层的安排 
 

菜单 Setup > Layer Definition 

在 PADS Layout 中定义层的安排，包括指定层的数量、内部 plane 层的网络关联、叠层

结构和层的厚度。  

本教程设计将被定义为两层板。  

设置第一层: 

1. 在 Layers Setup 对话框中，选择列表中的 Top 层。  

2. 在 Name 框中输入 Die Side。 

3. 在 Electrical Layer Type 区域，点击选择 Component。 

4. 在 Plane Type 区域，点击选择 No Plane。 

5. 设置 Routing Direction 为 Vertical。 
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设置第二层: 

1. 在层列表中选择 Bottom。 

2. 在 Name 框中输入 BGA Side。 

3. 在 Electrical Layer Type 区域，选择 Component。 

4. 在 Plane Type 区域，点击选择 No Plane。 

5. 设置 Routing Direction 为 Horizontal。 

提示: 不要关闭 Layers Setup 对话框。 

设置叠层结构 
 

Layers Setup 对话框 > Thickness 按钮 

一个典型的双面 FR4 板材叠层由一片玻璃树脂双面覆铜而成。使用 Layer Thickness 对
话框进行叠层参数值的设定。 

1. 在 Layer Thickness 对话框中，在 Die Side 层的 Thickness 单元双击，此单元进

入可编辑模式。 

2. 在 Thickness 单元输入 .01 (mm)。 

电子技术应用 www.ChinaAET.com



 

                                                                     19 

3. 在 BGA Side 层的 Thickness 单元双击，此单元进入可编辑模式。 

4. 在 Thickness 单元输入 .01 (mm)。 

5. 在 Substrate 的 Thickness 单元中双击鼠标左键，输入 2 (mm) 设置厚度。在同一

行的 Dielectric 单元中双击鼠标左键，输入 4.5 设置介电常熟值。 

 
6. 点击 OK 按钮关闭 Layer Thickness 对话框。 

7. 点击 OK 关闭 Layers Setup 对话框。 

修改默认的过孔参数 
 

菜单 Setup > Pad Stacks 

进入布线之前，你必须先修改默认的过孔设置。  

修改默认过孔设置: 

1. 在 Pad Stacks Properties 对话框中，在 Pad Stack Type 区域，点击 Via。 

2. 在 Decal Name 列表中选择 STANDARDVIA。 

3. 在 Sh.: Sz.: Layer: (shape, size, layer) 列表中，选择 CNN 0.254 <Start>。 

4. 在 Diameter 框中输入 .4。 

5. 在 Sh.: Sz.: Layer: 列表中选择 CNN0.254 <Inner Layers>。 

6. 在 Diameter 框中输入 .4。 

7. 在 Sh.: Sz.: Layer: 列表中选择 CNN 0.254 <End>。 

8. 在 Diameter 框中输入 .4。 

9. 在 Drill Size 框中，输入 .16。 
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10. 点击 OK 按钮保存过孔设置并关闭 Pad Stacks Properties 对话框。出现提示消息

Are you sure you want to change all vias of type STANDARDVIA？ 

 
11. 点击 是 按钮，确认修改过孔参数。 

设置默认完全间距规则 
 

菜单 Setup > Design Rules > Rules 对话框 > Default 按钮 > Default rules 对话框 > Clearance 按钮 
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在 PADS Layout 中，你可以定义安全间距规则、布线规则和高速设计约束以及针对每一

层的设计规则。Clearance 区域的安全间距规则对话框包含了设计数据矩阵，你可以在这

里设置各个项目之间的安全间距值。 

 

指定间距规则: 

1. 通过点击矩阵左上角的 All 设置全局的安全间距规则。  

2. 在 Input Clearance Value 对话框中输入 .07 并点击 OK 按钮。  

结果: 所有值同时进行了更改。 

 
3. 在 Trace Width 区域，输入： 

y 在 Minimum 框中输入 .07 

y 在 Recommended 框中输入 .07 

y 在 Maximum 框中输入 .5 

4. 在 Same Net 区域，在下列框中输入 .07：  

y Via to Via 

y SMD to Corner 

y SMD to Via 

y Pad to Corner 

5. 在 Other 区域的 Drill to Drill 和 Body to Body 框中输入 .07 

 
6. 在 Clearance Rules 对话框中点击 OK 按钮关闭此对话框。 
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7. 在 Default Rules 对话框中点击 Close 按钮关闭此对话框。 

 
8. 在 Rules 对话框中，点击 Close 按钮关闭并保存这些设置。 

 

使用在线设计规则检查 (DRC) 
 

在我们设计的布局和布线过程中，我们可以设定实时的设计规则检查功能，以保证在整个

设计过程中，不会违背设计规则，这个交互式的检查被命名为 DRC。你可以通过菜单中

的 Options 对话框进行设置，也可以通过 DR 无模命令进行设置。 

DRC 操作的四种模式: 

DRC 模式 描述 

DRC Off 关闭设计规则检查  
无模命令：dro 

DRC Ign Clr 忽略所有的间距规则除了走线交叉 
无模命令：dri 

DRC Warn 违规时提示错误信息 
无模命令：drw 

DRC Prevent  防止违反设置规则 
无模命令：drp 
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设置显示颜色 
 

菜单 Setup > Display Colors 

在 Display Colors Setup 对话框中，你可以指定或者改变层的颜色，或者设置单独的各

个项目显示或者不显示。你也可以设置背景颜色，板框颜色和其他项目。 

指定一个新的颜色给 BGA 

1. 在 Selected Color 区域点击选择一个淡蓝色。 

2. 在 Color by Layer 区域，在 Design Items 区域下，点击 BGA Side 行的每一个颜

色块，将其都设置为淡蓝色。 

指定其他项目的颜色 

1. 在 Selected Color 区域点击选择黄色。 

2. 在 Color by Layer 区域，在 Design Items 区域下，将 Die Side 层和 BGA Side 层

下的 Errors 项目颜色设置为黄色。 

 

保存颜色配置 

你可以保存颜色配置，以便在下一个设计中应用。当你在 Display Colors Setup 对话框

中完成了颜色设置，保存颜色配置。 

1. 点击 Save 按钮。 

2. 在 Save configuration 对话框中，输入 All Items Visible 
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3. 点击 OK 保存此颜色配置。 

4. 点击 OK 应用此颜色设置并关闭 Display Colors Setup 对话框。 

5. 不要保存此设计。 
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第五节 建立 wire bond 扇出 

本节将学习: 

y 建立一个 wire bond 扇出 

y 扫描其他的 wire bond 选项 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_4.pcb 文件。 

建立 wire bond 扇出 
 

BGA 按钮   

开始 Wire Bond 向导: 

1. 点击鼠标右键选择 Select Components 

2. 选择 die 元件 U1，如果需要切换选择元件，可以使用 Tab 键。 

3. 在 BGA 工具条上，点击 Wire Bond Wizard 按钮打开 U1 元件的 Wire Bond 
Wizard。 
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定义环几何形状 
Wire Bond Wizard 对话框 > Guide 表格 

定义环尺寸: 

1. 在 Wire Bond Wizard 的 SBP Rings 区域，选择 Ground 

2. 在 Size 区域，在 X 和 Y 框中输入 0.5，并选择下面的 Distance from Die 

3. 在 SBP Rings 区域，选择 Power 

4. 在 Size 区域，在 X 和 Y 框中输入 1.25，并选择下面的 Distance from Die 

5. 在 SBP Rings 区域，选择 Signal 

6. 在 Size 区域，在 X 和 Y 框中输入 2，并选择下面的 Distance from Die 

7. 在 Shape 区域，在列表中选择 Arced ，并在 Heigth 值框中输入 0.8 
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设置扇出参数 
Wire Bond Wizard 对话框 > Fanout Prefs 表格 

设置环的扇出参数: 

1. 在 SBP Rings 区域，通过按住 Ctrl 键进行多选 Ground 和 Power rings。 

2. 在 Substrate Bond Pad 区域，在 Shape 列表中，选择 Rectangle 

3. 在 Length 和 Width 框中，输入 .04 

4. 在 Focus 区域，选择 CBP 指定 substrate bond pad 对齐到元件的 bond pads。 

5. 在 Wire Bond 区域，在 Width 值框中输入 .025，在 Offset 框中输入 0 

6. 在 SBP Ring 区域选择 Signal ring。 

7. 在 Substrate Bond Pad 区域的 Shape 列表中选择 Oval 

8. 在 Length 框中输入 .3 

9. 在 Width 框中输入 .1 

10. 在 Focus 区域，选择 CBP 指定 substrate bond pad 对齐到元件的 bond pads。 

11. 在 Wire Bond 区域，在 Width 值框中输入 .025，在 Offset 框中输入 0 

 

指定 wire bond 规则 
Wire Bond Wizard 对话框 > Rules 区域 > Wire Bond Rules 按钮 
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指定扇出规则: 

1. 选择所有的规则检查勾选框。 

2. 在 WB to WB Clearance 框中输入 .03 

3. 在 WB to SBP Clearance 框中输入 .03 

4. 在 Min Length 框中输入 .5 

5. 在 Max Length 框中输入 2.9 

6. 在 Max Angle 框中输入 45 

 
7. 点击 OK 关闭 Wire Bond Rules 对话框。 

分配 chip bond pads 到环 
Wire Bond Wizard 对话框 > Assign CBPs 按钮 
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分配 pads 到环: 

1. 在 Assign CBPs to Rings 对话框，在 View by 列表中，选择 CBP Function 

2. 在 CBP Function 列中，选择 GND 

3. 在 Assign to 区域，勾选 Ground 选项框 

4. 点击 Apply 按钮 

结果: 所有 GND 功能名称的 CBPs 均被指派到 Ground 环 

5. 在 CBP Function 列，选择 PWR 

6. 在 Assign to 区域，勾选 Power 选项框 

7. 点击 Apply 按钮 

结果: 所有 PWR 功能名称的 CBPs 均被指派到 Power 环 

8. 点击 Select All 按钮选择其他剩余的 CBP 功能名称 

9. 在 Assign to 区域，勾选 Signal 选项框 
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10. 点击 Apply 按钮 

结果: 剩余的 CBPs 都被指派到 Signal 环 

11. 点击 Close 按钮关闭对话框 

指定 wire bond 扇出策略 
Wire Bond Wizard 对话框 > Strategy 表格 

Strategy 表包含了改善布线和加工易操作性的选项设置。 

指定策略: 

1. 在 SBP Rings 区域，按 Ctrl 键的同时点击 Ground 和 Power 环 

2. 在 Preferred Spacing 区域，勾选 WB to SBP 选项框 

3. 在 WB to SBP 框中，输入 .07 指定首选的 wire bond 到 substrate bond pad 的
间距 

4. 勾选 Force Preferred Spacing 选项框 

5. 在 SBPs Having Same Function Name 区域，勾选 Create Nets from Pin 
Function 

 
6. 在 SBP Rings 区域，选择 Signal 环 

7. 在 Preferred Spacing 区域，勾选 SBP to SBP 选项框 

8. 在 SBP to SBP 框中，输入 .1 指定首选的 substrate bond pad to substrate 
bond pad 间距 

9. 勾选 Force Preferred Spacing 选项框 
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10. 在 SBPs Having Same Function Name 区域，勾选 Create Nets from Pin 
Function 选项框 

预览和检查 wire bond 扇出 

预览扇出: 

1. 在 Wire Bond Wizard 对话框的 Preview Options 区域，勾选 Report 选项框 

2. 点击 Preview Fanout 按钮，wire bond 扇出效果在工作区域显示出来并产生 Wire 
Bond Wizard 报告 

3. 浏览报告内容，注意在 Signal 环上有最大长度违规，我们设置违规的目的是为了说明

违规检查和报告的功能 

4. 关闭报告文件 

5. 点击 Wire Bond Rules 按钮，改变 Max Length 到 3，关闭 Wire Bond Rules 对

话框，参考“指定 Wire Bond 规则”部分，获取更多信息 

6. 再次点击 Preview Fanout 按钮，浏览 Wire Bond Wizard 报告发现原来的最大长

度违规(Max Length violations)已经没有了 

7. 关闭报告文件 

 

产生 wire bond 扇出 
Wire Bond Wizard 对话框 > Create Fanout 按钮 

当你点击了 Create Fanout 按钮后，出现一个对话框提示说建立了 GND 和 PWR 网络 
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完成扇出: 

1. 点击 Close 关闭对话框  

结果: Wire Bond Wizard 报告产生 

2. 浏览报告文件，然后关闭它 

 
3. 点击 OK 按钮关闭 Wire Bond Wizard 

扫描其他的 wire bond 选项 
 

Wire Bond Wizard 按钮   

上面的步骤说明了基本的建立 wire bond 扇出模式，你可以使用其他的控制微调结果。  

从网络表导入 SBP 功能名称 

Substrate Bond Pad 功能名称与 Chip Bond Pad 功能名称相匹配，某些情况下你可能

需要让 Substrate Bond Pad 功能名称反映相关的网络名。 
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导入焊盘功能名称: 

1. 在工作区域点击 die U1，这将打开 U1 的 Wire Bond Wizard 对话框 

2. 在 Wire Bond Wizard 对话框中，点击 SBP Naming 按钮 

 
3. 点击 Derive from Netlist 按钮 

4. 在 \PADS Projects\Samples 目录下，双击 SBPnetlist.asc 文件并导入 

5. 点击 OK 关闭 SBP Naming 对话框 

保存和载入设置文件 
Wire Bond Wizard 对话框 > Load Setup 按钮 

当你对目前的 wire bond 设置满意时，你可以将其保存，以后在另外一个设计中再次使

用此设置。点击 Save Setup 保存所有的参数到一个文件，而 Chip Bond Pad 分配将不

会被保存，因为每个设计的分配都不一样。 

载入一个已有的 wire bond 设置文件: 

1. 在 \PADS Projects\Samples 目录下，选择点击 PBGAtutorial_4.wbw 文件 

2. 点击 Open 读入此文件 

3. 不要保存此设计 
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第六节 编辑 Wire Bond Pads 

完成了 wire bond 扇出模板后，你可能需要对其做一些调整。  

本节将学习: 

y 修改 substrate bond pads 

y 检查 wire bond 规则 

y 增加 wire bonds 和 substrate bond pads  

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_5.pcb 文件。 

修改 substrate bond pads 
 

更改 bond pad 形状 

更改 substrate bond pad 的形状: 

1. 首先点击 BGA 图标 ，并将视图放大到 wire bond 扇出的右上角区域 

2. 使用无模命令 g .01 设置格点为 .01  

3. 点击鼠标右键选择 Select Traces/Pins. 

4. 使用无模搜索命令 s u1.65 并按回车键，这将移动鼠标指针到 U1.65 substrate 
bond pad，再按空格键选择它 

5. 高亮选择 U1.65 substrate bond pad 后，点击鼠标右键选择 SBP Properties 

6. 在 Shape 区域，在 Shape 列表中，选择 Rectangle 

7. 在 Shape 区域，在 Length 框中输入 .5 并点 Apply 按钮 

结果: substrate bond pad 根据新输入的参数进行了更新 
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8. 点击 Cancel 按钮关闭此对话框 

9. 在标准工具条中，点击 Undo 按钮取消刚才的修改操作 

提示: 你可以通过 SBP Properties 对话框修改个别的或者一组的 substrate bond pads
参数。 

移动 substrate bond pads 

移动一个 bond pad: 

1. 使用以上相同的方法选择 bond pad U1.65 
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2. 点击鼠标右键选择 Move SBP 

3. 移动鼠标指针并注意看 substrate bond pad 是如何动态地跟随鼠标移动的，并注意

看前面在 Wire Bond Wizard 中定义的环的参考显示的变化。 

SBP 和 rings: 

 
4. 移动鼠标指针使得 substrate bond pad 到 signal 环外，现在再将 substrate bond 

pad 移动回到 signal 环上，并注意自动捕捉环的动作。 

5. 移动并放置 substrate bond pad 于如图位置 

提示: 你可以在 Options 对话框的 Die Component 页面中设置 wire bond 捕捉的相关

参数。 
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检查 wire bond 规则 
 

菜单 Tools > Verify Design 

检查 wire bonds: 

1. 在 Check 区域选择 Wire Bonds 

2. 点击 Start 按钮，出现提示信息 Wire Bond rules checking has been done for the 
current window. Number of errors found—3 

 
3. 点击 确定 按钮 

4.  注意在相应的区域显示了违规标志并在窗口的 Explanation 区域显示每个违规的说

明。 

 

 
5. 在 Verify Design 窗口中点击 Clear Errors 按钮，再点击 Close 按钮关闭对话框。 
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6. 在标准工具条上点击 Undo 按钮，取消前面的修改操作。 

添加 wire bonds 和 substrate bond pads 
 

BGA 按钮   > Wire Bond Editor 按钮   

某些网络需要增加额外的 wire bonds 和 substrate bonds 以增加载流能力。 

添加一个 pad: 

1. 选择 U1 die 元件 

2. 放大视图到 wire bond 扇出的右上角区域 

3. 点击鼠标右键选择 Add SBP 

4. 在 Add Substrate Bond Pad 对话框中，在 Function 框中输入 GND  

5. 点击 Add 按钮接受这些参数并关闭对话框 

 
6. 一个新的 substrate bond pad 黏附于鼠标指针上，同时显示环的参考提示 

7. 放置新的 substrate bond pad 于内环(GND) substrate bond pad 右边的上面一些

的位置，新的 substrate bond pad 仍保持被选择的状态 

8. 点击鼠标右键选择 Add WB，一条新的 wire bond 从新的 substrate bond pad 连

接到鼠标指针上 
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SBP 放置和 wire bond 连接: 

 
9. 移动鼠标指针连接新的 wire bond 到 die 的右边最上面的一个 CBP 上 

10. 鼠标右键选择 Cancel 

11. 点击 Exit Wire Bond Editor 

 
提示: 进行了交互式的 wire bond 编辑后，你必须进入 Verify Design 再次进行编辑

的检查。 

12. 不要保存此设计文件 
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第七节 连接网络表 

你可以利用 BGA 工具条上的工具建立一个网络表和建立交互式的连接 

本节将学习: 

y 导入部分网络表 

y 显示和隐藏连接 

y 交互式地建立连接  

y 交互管脚 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_5.pcb 文件。 

导入部分网络表 
 

菜单 File  > Import 

这里你将分配 power 和 ground 给球阵列焊盘 

1. 在\PADS Projects\Samples 目录下选择 PGnetlist.asc 文件 

2. 点击 Open 导入此网络表文件  

本文件中，PWR 和 GND 被指派给相应的球阵列焊盘 

显示和隐藏连接 
 

菜单 View > Nets 

为了不至于显示太过混乱，你可以打开或者关闭连接的显示，在这一步我们关闭 power
和 ground 的连接显示但是让管脚高亮 

1. 在 Net List 区域，通过 Ctrl 键多选 PWR 和 GND 网络 

2. 点击 Add 按钮添加 PWR 和 GND 网络到 view list 列表中 

3. 在 View List 区域，通过 Ctrl 多选 PWR 和 GND 网络 

4. 在 View Unroutes Details 区域，选择 None 

5. 在 Color by Net 区域，选择深灰色颜色块点亮 PWR 和 GND 管脚 
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6. 点击 OK 接受以上设置并关闭对话框，连线被取消显示但是 PWR 和 GND 网络的管

脚被点亮 

 

建立交互式的连接 
 

BGA 按钮   > Add Connection 按钮   

一些高级的 IC 封装设计不要求固定的网络表，这种情况下它的连接关系就留给设计者来

决定了。以下的练习展示了如何进行交互式的管脚分配连接和交换管脚 
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放大区域: 

 
1. 按照图示的位置放大 wire bond 扇出的左上角位置 

2. 使用无模命令 s u1.248 并按回车键，再按空格键开始连接 

3. 点击鼠标右键选择 Derive Net Name from Pin Function，这将自动地基于管脚

的功能名称分配网络名  

 
4. 使用无模搜索命令 s bga1.g4 并按钮回车键和空格键 

5. 按 Esc 键结束连接 

6. 重复以上的步骤，添加以上图示的连接 

交换管脚 
 

Swap Pin 按钮   

1. 输入无模命令 s bga1.g4 并按回车键  

2. 按空格键选择第一个需要交换的管脚，其他的管脚将变暗显示 

3. 选择左边相邻的球形焊盘 (BGA1.G3) 

4. 在弹出的确认对话框中，勾选 Don’t display again 选项，点击 OK 关闭对话框 

结果: 两个管脚之间的连接被关系被交换 

5. 重复以上的步骤，如果操作失误，可以点击鼠标右键选择 Undo Last Swap 

6. 不要保存此设计 
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第八节 无网络表的连接 

在 PADS Layout 中有几种工具用来连接 substrate bond pads 到 BGA pads，在本节

教程中，你将学习使用这几种工具。  

本节将学习: 

y 使用手工布线编辑器 

y 开始布线 

y 完成布线 

y 获取网络名 

y 引导焊盘入口 

y 平滑焊盘出入口 

y 修改走线 

y 使用动态布线编辑器 

y 拷贝走线 

y 建立一个扇出模板 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_6.pcb 文件。 

使用手工布线编辑器 
 

PADS Layout 中的核心布线编辑功能就是是基本的布线编辑器，在布线编辑器中许多建

立走线的操作类似于其他的操作，例如建立多边形和 line 项目。这样就最小化了你的学

习时间，使得许多操作都可以以类似的操作应用于不同的地方。 

一般在 PADS Layout 中，所有的飞线连接都将通过换层以及鼠标和键盘的配合使用，被

转化为走线。当然你也可以连接一个没有网络表的走线，在以下的练习中，你将使用布线

编辑器通过飞线建立走线。  

调整视图大小 

1. 通过 Ctrl+B 浏览整个设计文件 

2. 将视图放大到 U1 元件的右上角位置 

3. 使用无模命令定位 substrate bond pad 65 的位置 s u1.65 并按回车键，鼠标指针

移动到 U1.65 位置 
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设置布线和过孔的格点 

为了更容易地走线和放置过孔，设置走线的格点为 0 和过孔的格点 0.1。通过以下的无模

命令： 

1. 将工作格点设置为 0 ，输入 g0 并按回车键。状态栏出现提示信息 All grids set to 
0.00025 0.00025  

2. 设置过孔格点为 0.1，输入 gv.1 并按回车键。状态栏出现提示信息 Via grid set to 
0.1 0.1  

开始布线 
 

BGA 按钮   > Add Route 按钮   

1. 在没有选择任何目标的情况下，点击鼠标右键选择 Select Pins/Vias/Tacks 

2. 在标准工具条上，从 Layer 列表中选择 Die Side 做为当前层 

3. 使用无模命令 ao 设置走线角度模式为直角方式 

4. 在 Die Side 层点击选择 substrate bond pad U1.65，鼠标指针上将动态地黏附走

线的线段。 

提示: 目前 PADS Layout 中的 DRC 模式是关闭的，新的走线段将不会阻止其与其他

目标之间的短路 

5. 一旦你开始了新的走线，移动鼠标指针注意观察走线的形式 

提示:  

y 新的走线段被约束了只能以 90 度的角度进行走线，这是因为我们前面设置了走线

角度模式为直角方式 

y 在此练习中，你可以随时按 Esc 键退出走线操作模式，也可以点击工具条上的

Undo 按钮撤销之前的操作 

改变走线角度模式 

你可以在布线的过程中通过点击快捷菜单的命令改变走线角度模式 

改变走线角度模式: 

1. 当走线的线段黏附与鼠标指针上时，点击鼠标右键选择 Angle Mode，再选择 
Diagonal 

2. 移动鼠标指针，请注意此时新的走线角度变为了 45 度模式 

添加和删除拐角 

你可以通过点击鼠标左键添加新的走线拐角，要删除新的走线段，可以按键盘上的退格键

Backspace。 
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更换走线层 

在走线过程中，按住 Shift 键，使用类似于添加拐角的方法来换层。你可以在目前鼠标指

针所在处或者最后一个拐角处添加过孔换层。  

在当前鼠标指针位置换层: 

y 当一段走线段黏附在鼠标指针上时，按 Shift 键同时点击鼠标左键 

结果: 一个新的过孔被添加到当前鼠标指针位置处，同时切换到层对的第二个走线层

并变成当前层。 

 可选方法: 如果需要在前一个拐角处换层，按 F4 或者点击鼠标右键选择 Layer 
Toggle。 

选择新 走线的终点 

在你结束新的走线之前，你必须选择一个终点。有两种方法供选择：选择目标命令或者双

击鼠标左键。 

通过选择目标命令: 

1. 将黏附于鼠标指针上的走线段，点击鼠标右键选择 Select Target 

 
2. 将鼠标移动到目标位置，然后点击鼠标左键 

鼠标指针返回到走线段末端 

通过双击鼠标左键: 

y 将黏附于鼠标指针上的走线段移动到目标管脚处，双击鼠标左键完成 

完成走线 
 

有两种方法完成走线，使用“开始走线”部分的从 substrate bond padsYou can 
complete a trace in two ways. Use the steps in the "Start Routing" section to 
route traces from the substrate bond pads. 

提示: 记住：你正在走的线是从 substrate bond pad 到 ball grid pad，它们位于不同的

层，你必须通过增加过孔才可以完成走线。 
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通过 complete 命令完成走线: 

1. 从一个 substrate bond pads 开始一段新的走线 

2. 通过右键点击选择 Select Target 而选择目的焊盘 

3. Shift+click 插入一个过孔 

4. 当走线段黏附于鼠标指针上时，点击鼠标右键选择 Complete 

可选方法: 双击鼠标左键  

结果: 走线自动完成布线到目的焊盘并平滑处理 

不通过 complete 命令完成走线: 

1. 从一个 substrate bond pads 开始一段新的走线 

2. 通过右键点击选择 Select Target 而选择目的焊盘 

3. Shift+click 插入一个过孔 

4. 当走线段黏附于鼠标指针上时，将鼠标指针定位于 BGA 焊盘的中心 

5. 当“牛眼”符号出现时，点击鼠标左键 

结果: 走线完成，一般情况下不进行平滑处理 

提示: 在此练习中，你可以随时按 Esc 键退出走线操作模式，也可以点击工具条上的

Undo 按钮撤销之前的操作 

获取网络名 
 

默认情况下 PADS Layout 命名所有的新网络名为 $$$<数字>，当进行高级封装设计

时，你可能更想让 die pad 连接到 BGA pad 的网络连接具有和 die pad 相同的功能名称

或者信号名称。例如，die pad 的 RESET 信号连接到 BGA pad 时，我们想让这个网络

名称为 RESET。 

PADS Layout 可以在添加走线时从管脚的功能名获取网络名，在执行 Add Route 命令

时，你可以通过快捷菜单打开或者关闭这个功能。 

打开此选项: 

1. 从 substrate bond pad 开始一个新的走线 

2. 在走线开始后，点击鼠标右键勾选 Derive Net Name from Pin Function 选项。

前面的一个小勾说明这个功能被打开了。 

执行上面的操作后，这个功能将一直被打开，直到你再次选择此选项将关闭此功能。 

引导焊盘入口 
 

菜单 Tools > Options > Routing 表格 
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为了达到最优的焊盘出入口模式，根据你的走线引导焊盘出入口，当这个选择打开时，开

始走线时的角度将临时被切换到任意角度模式，直到你放置了第一个走线拐角后，角度模

式才会恢复到当前的设置。 

引导焊盘入口: 

1. 在 PADS2007 中，在 Options 区域，勾选 Any angle pad entry （在

PADS2005 及之前版本中：在 Pad Entry 区域，勾选 Guide Pad Entry） 

2. 点击 OK 按钮 

开始布线 

1. 在没有选择任何目标时，点击鼠标右键选择 Select Pins/Vias/Tacks 

2. 使用无模命令 drp，打开 DRC 保护模式 

3. 输入无模命令 ao，设置走线角度模式为直角方式 

4. 在层列表中选择 Die Side ，将其设置为当前层 

5. 在 BGA 工具条上点击 Add Route 图标按钮 

6. 选择 SBP 上的 U1.65，这是鼠标指针上将黏附一段新的走线 

焊盘出口操作演示: 

1. 沿着焊盘周围移动鼠标，请注意看第一段走线是否是任意角度模式 

2. 在离这个焊盘很近的区域移动鼠标指针，请注意这时有一个八角型的 DRC 违规指示

符出现。这个指示符说明在当前鼠标指针位置添加第一个拐角将违背 same net SMD
到拐角的安全间距设置值。因此，在鼠标指针位置是不能添加拐角的，直到移动鼠标

指针稍微远离焊盘八角型指示符消失为止。 

3. 移动鼠标指针到八角型指示符消失的位置，点击鼠标左键，确定第一个拐角。 

4. 在第一个拐角附近移动鼠标指针，注意观察此时走线的角度变为了直角模式。 

焊盘入口操作演示: 

1. 继续进行新 的走线，点击鼠标右键并选择 Select Target（而不是双击鼠标），选择

目的焊盘。 

2. 根据走线需要增加一些走线段并按 Shift+click 增加一个过孔，朝着目标焊盘的中心

引导鼠标指针。  

结果: 当“牛眼”符号出现时，最后一段走线立即变成了任意角度模式。 

提示: 你在 BGA 焊盘一端看到“牛眼”符号，所以你必须增加一个过孔换层。 

3. 在目标焊盘中心处点击鼠标左键，完成走线。 

平滑焊盘出入口 
 

菜单 Tools > Options > Routing 表格 
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另外一个选项是决定在布线的过程中焊盘出入口是否被平滑。默认此选项是关闭的。 

打开平滑焊盘出入口选项: 

1. 在 Smoothing Control 区域（PADS2005 及之前版本在 Pad Entry 区域），勾

选 Smooth Pad Entry/Exit 选项 

2. 点击 OK 

操作练习 

在打开 Smooth Pad Entry/Exit 选项的情况下，执行以上的手工操作，以便熟悉这些操

作。 

修改走线 
 

你可以通过选择一段走线或者过孔进行走线的修改，通过鼠标右键选择可用的命令，如果

在 DRC Off 模式下，你可以更加自由地修改走线。 

删除走线和线段 

你可以很容易地删除走线段或者 pin pairs 

删除走线和线段: 

1. 在没有任何目前选中的情况下，点击鼠标右键选择 Select Anything 

2. 选择一段完成的走线段，按键盘上的删除键 Delete 

3. 点击标准工具条上的 Undo 按钮，取消刚才的删除操作 

4. 通过 Shift+click， 选择整个 pin pair 走线 

5. 按 Delete 键，删除整段 pin pair 的走线。如果在 DRP 保护模式（设置为

Prevent、Ignore 或者 Warn），将出现提示信息：Delete Pin Pairs or Unroute 
Traces? 点击选择 Unroute 

 

走线编辑命令练习 

通过选择不同的线段、过孔和拐角，练习走线编辑命令。使用快捷菜单或者键盘快捷键进

行移动、stretch、分割、添加拐角、添加过孔或者其他的编辑命令。详细命令信息见

PADS Layout Help。 
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使用动态布线编辑器 
 

BGA 按钮   > Dynamic Route 按钮   

动态布线编辑器 DRE（Dynamic Route Editor）是另一个强大的交互式布线工具。不

同于基本走线中手工添加一段一段的走线，你可以通过简单地移动鼠标指针，走线将动态

地根据你的鼠标指针移动路径进行添加。 

注意：动态布线必须是在 DRC 模式打开的情况下，因此在点击选择此图标时，请先输入

无模命令 drp 

动态布线: 

1. 在没有任何目标被选择的情况下，点击鼠标右键选择 Select Pins/Vias/Tacks 

2. 输入无模命令 ao，设置角度模式为直角模式 

3. 如果需要，将视图放大到设计的上部份，以便于走线 

4. 输入无模命令 s u1.65，将鼠标定位于 substrate bond pad 的 65 pin 位置 

5. 选择了 pin 65 并开始动态走线，一段走线将动态地黏附于鼠标指针上 

6. 移动鼠标指针往右上方向操作 SBP 方向接近，添加一个过孔后，移动鼠标到上面的焊

盘区域，请注意此时走线是如何规避焊盘并在焊盘之间自动穿越过去的。 

DRE 操作练习 

通过 DRE 模式练习添加走线越过各个障碍的焊盘，一旦你准备选择连接到一个目的焊

盘，可以使用之前的练习中的命令。 

提示: 在 DRE 模式下，为了撤销前面的一段走线，只有将鼠标指针根据刚才的路径稍微

回退一些即可。 

1. 通过输入无模命令 ad，更改走线的角度模式为 45 度角  

2. 继续同样的操作练习，再通过无模命令 aa 进行任意角度的操作练习 

提示: 在这个 DRE 操作在任何时候，你可以通过按键盘的 ESC 键退出。你也可以按标准

工具条上的 Undo 按钮撤销任何的操作。 

使用 DRE 走线 

使用 DRE 布线，许多在手工布线中的命令同样适用于动态布线： 

y 退格键删除最后一段走线 

y Shift+click 在目前鼠标位置添加一个过孔并换层 

y Ctrl+click 在目前鼠标位置结束一段走线，以过孔或者没有过孔结束 

使用 DRE 重布线 

你也可以使用与手工布线相似的方式在 DRE 中进行重布线 
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DRE 的重布线: 

1. 点击鼠标右键选择 Select Traces/Pins 

2. 选择任意一段走线，如果没有在动态布线模式，点击鼠标右键选择 Dynamic Route 

3. 建立一段新的走线后，在原走线路径上的某个位置双击鼠标左键完成重新布线。 

拷贝走线 
 

你可以通过拷贝走线和线段的方式加快重复的走线的进度。在这一节中，我们将使用走线

拷贝的方式快速地建立 BGA 焊盘的扇出。 

准备 

1. 打开目录\PADS Projects\Samples 下的文件 PBGAtutorial_6b.pcb  

2. 点击菜单 View 下的 Board 以便浏览整个设计 

3. 放大视图到设计的右上方部位，并将某个 BGA 焊盘置于视图的中心 

设置一些参数 

我们先对走线和过孔的格点以及其他参数做一些设置 

参数设置: 

1. 输入无模命令 g0 将工作格点设置为 0 

提示: 在状态栏将出现提示信息 

2. 输入无模命令 gv.1 设置过孔格点为 0.1 

3. 输入无模命令 ad 设置角度模式为 45 度模式 

4. 输入无模命令 e 设置为过孔结束模式  

结果: 在状态栏出现提示信息 End Via Mode Set，如果需要切换到 End No Via 
Mode Set ，再重复输入无模命令 e 两次即可 

5. 输入无模命令 dro ，将设计规矩检查功能关闭 

建立一个扇出模板 
 

BGA 按钮   > Add Route 按钮   

在拷贝走线之前，我们必须先建立一个扇出走线将其做为拷贝的模板  

建立模板: 

1. 在标准工具条上，在层列表中切换当前层到 BGA Side 
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2. 选择右上角的一个管脚并引出走线  

结果: 开始一段新的走线 

3. 移动鼠标指针到下图所示的位置，Ctrl+click 结束走线并自动添加一个过孔 

过孔位置: 

 

拷贝走线: 

1. 通过点击 BGA 工具条上的选择 Select 按钮，返回到选择模式 

2. 在没有任何目标选中的情况下，点击鼠标右键选择 Select Traces/ Pins/ 
Unroutes 

3. 将鼠标定位于刚才所走的那段斜走线并点击选择它 

4. 将鼠标定位于过孔位置并按 Ctrl+click 添加过孔到被选中目标中 

5. 在菜单 Edit 下选择 Copy，这时一段被拷贝的走线黏附在鼠标指针上 

6. 点击鼠标右键选择 Next Base Point 

7. 将黏附有线段的鼠标指针移动到下一个 BGA 焊盘上并点击鼠标左键，添加一段拷贝

的走线，并且鼠标指针自动跳到下一个焊盘 

8. 点击鼠标右键选择 Repeat.. 

9. 在 Copy Route Repeat 对话框中，输入 10 并按 OK 按钮  

结果: 10 个拷贝的走线和过孔被添加 
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10. 点击鼠标右键选择 Cancel 

提示: 你不能通过 Esc 退出当前的拷贝模式，如果对拷贝的结果不满意，可以使用

Undo 按钮撤销操作 

11. 不要保存此设计 
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第九节 使用布线向导 

BGA Route Wizard 是一个自动产生连接关系并自动布线的工具，它避免了重复和乏味

的设计任务，BGA Route Wizard 有两种操作模式： 

y 产生连接关系 − 在 substrate bond pads 和 BGA package pads 之间自动产生连接

关系，它能够计算最短的连接长度和最少的布线交叉。 

y 产生连接关系比布线 − 产生上面的模式类似的网络表，并利用已建立的设计规则自动

进行布线。 

本节将学习: 

y 开始 BGA Route Wizard 

y 设置布线参数 

y 选择处理的焊盘 

y 设置 BGA 扇出参数 

y 运行 BGA Route Wizard 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_6.pcb 文件。 

开始 BGA Route Wizard 
 

BGA 按钮   > Route Wizard 按钮   

y 在 BGA Route Wizard 对话框的 Action 区域，选择 Generate Connections and 
Route 

结果: Routing、Select Pads 和 BGA Fanouts 表格可用 
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设置布线参数 
 

BGA Route Wizard > Routing 表格 

在 Routing 表中设置线宽、plating tail 和其他与布线相关的选项，网络名参数选项在这

个表中也可用。  

设置布线参数: 

1. 在 Include 区域，确保  Plating Tails 已经被勾选 

2. 在 Plating Tails 区域，在 Tail Length 框中，输入 1  

3. 在 Net Name Preferences 区域，勾选 Derive Net Name from Pin Function 

选择处理的焊盘 
 

BGA Route Wizard > Select Pads 表格 

使用 Select Pads 表格来指定哪些封装的焊盘和 SBP 需要处理，你可以点击单独的焊盘

或者整个封装的一个边的焊盘。默认情况下，处理所有的封装和 SBP 焊盘。 

排除 BGA 中间的焊盘: 

1. 点击 Select Graphically 
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结果: BGA Route Wizard 对话框关闭，Select Graphically 对话框出现 

2. 点击选择 Select Pins to Exclude 

3. 拖动鼠标指针从坐标 -10.7, -9.4 到 -9.5, 9.6 ，选择内环左边的一列焊盘 

结果: 焊盘被白色高亮 

选择的焊盘: 

 
4. 重复以上的步骤，将剩余的三个方向的焊盘也全部选中，请记住必须按 Ctrl 键进行

多选 

5. 点击 OK 按钮，Select Graphically 对话框关闭，BGA Route Wizard 出现，刚才

选择的那些管脚被添加到 BGA pins 区域的 Excluded 列表中 

 

排除指派给 GND 和 PWR 网络的焊盘: 

1. 在 Substrate Bond Pads 区域，在 Included 列表下，点击 Net 列对焊盘按网络名

进行排序  
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2. 通过 Ctrl+click 多些所有连接到 GND 和 PWR 的 substrate bond pads 

3. 在 Substrate Bond Pads 区域，点击 Exclude，这样就在 SBP 区域排除了所有的

连接到 GND 和 PWR 的焊盘 

4. 重复同样的步骤，在 BGA 列表中排除你需要排除的焊盘 

5. 浏览 substrate bond pads 和 BGA pins 的 Included 列表，确保列表中没有 PWR 
或者 GND 网络 

 

设置 BGA 扇出选项 
 

BGA Route Wizard > BGA Fanouts 表格 

你可以通过 BGA Fanouts 表格控制扇出的类型、方向和线宽 

设置选项: 

y 在 Fanout Style 列表中，选择 Diagonal 
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运行 BGA Route Wizard 
 

BGA Route Wizard > Run 按钮 

建立连接、走线和 plating tails 

运行产生连接关系和布线: 

提示: 你可以通过按 Esc 将随时中断处理过程 

1. 当处理完成后，将产生一个报告文件。 

2. 不要保存此设计 
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第十节 添加泪滴 

PADS Layout 具有自动添加泪滴的功能，在本节，你将学习如何设置泪滴参数和添加泪

滴。  

本节将学习: 

y 打开产生泪滴功能 

y 修改泪滴几何尺寸 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_7.pcb 文件。 

打开产生泪滴功能 
 

菜单 Tools > Options > Routing 表格 

你需要在 Options 对话框的 Routing 表中打开泪滴产生选项，一旦你打开了此选项，泪

滴将自动添加到每个走线的过孔或者焊盘端；关闭此选项，将删除先前产生的泪滴。 

打开泪滴产生选项: 

y 选择 Generate Teardrops，点击 OK 按钮 

结果: 泪滴立即自动添加到每个走线和过孔端 

 

修改泪滴几何尺寸 
 

现在你学会了产生和删除泪滴，你还可以调节泪滴的几何尺寸。在本部分，你将学习如何

更改一个或者多个泪滴的几何尺寸。 
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调整视图大小 

1. 按 Ctrl+B 浏览整个设计 

2. 放大设计，放大部分 BGA 焊盘和扇出到过孔的部分 

修改泪滴参数 

通过选择一段带泪滴的走线，打开泪滴属性窗口，通过此窗口调节被选择泪滴的参数，修

改的应用范围可以是本泪滴、所有泪滴以及当前层的泪滴。 

修改泪滴: 

1. 在没有选择任何目标的情况下，点击鼠标右键选择 Select Traces/Pins 

2. 选择一段连接到 BGA 焊盘的斜线段，点击鼠标右键选择 Teardrop Properties，一

段斜走线段将比较难于被发现，它位于泪滴的中心位置 

3. 在 Teardrop Properties on Traces 对话框中，在 Apply to 区域点击 All 将修改应

用于所有泪滴 

 
4. 在 Shape 区域，点击选择 Line 按钮  

5. 在 Length Ratio 和 Width Ratio 框中，输入 100 

6. 在 Parameters 区域，勾选 Auto Adjust  

7. 点击 OK 

结果: 处理完成后，所有的泪滴被更改为类似锥形的形状 

 
8. 不要保存此设计 
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第十一节 建立 Die flag 和电源环 

PADS Layout 提供了参数化构造 die flag 和电源环的功能  

本节将学习: 

y 设置灌铜格点 

y 定义 die flag 

y 增加电源环  

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_8.pcb 文件。 

设置灌铜格点 
 

菜单 Tools > Options > Grids 表格 

设置灌铜格点: 

1. 在 Hatch Grid 区域，在 Copper 和 Keepout 框中，输入 0 

2. 点击 OK 按钮 

电源 die flag 
 

BGA 按钮   > Die Flag Wizard 按钮   

调整视图大小，浏览 die 和 wire bond 扇出的区域 

1. 在没有任何目标选择的情况下，点击鼠标右键选择 Select Component 

2. 选择元件 U1 
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3. 在 Die Flag and Rings 区域，确保 Die Flag 被勾选 

4. 在 Layer 列表中，选择 Die Side 

5. 在 Shape 列表中，选择 Rounded Rectangle 

6. 在 Spacing 框中，输入 0.25 

7. 在 Width 框中，输入 0.5 

8. 在 Net 列表中，选择 GND 

9. 在 Spokes 区域，做以下操作: 

y 在 Number 列表中选择 8 

y 在 Width 框中输入 0.6 

y 在 Miter Size 框中输入 0.1 

y 选择 Project from corners 

10. 在 Center Paddle 区域，在 Coverage 框中输入 50 

结果: 工作区域将更新显示新的 die 标志参数 
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增加电源环 
 

1. 在 Die Flag and Rings 区域，点击 Add 

结果: 一个新的环名字 Ring1 被增加 

2. 在 Die Flag and Rings 区域，选择 Ring1 

3. 在 Layer 列表中，选择 Die Side 

4. 在 Shape 列表中，选择 Rounded Rectangle 

5. 在 Spacing 框中，输入 0.25 

6. 在 Width 框中，输入 0.5 

7. 在 Net 列表中，选择 PWR 

8. 点击 Create 按钮产生 die flag 和电源环的铜皮 

提示: 如果需要删除已建立的 die flag 和电源环， 可以通过选择 Shapes，拖动窗口

选择 die flag 和电源环，然后按 Delete 键。 

 
9. 不要保存此设计 
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第十二节 连接 Power 和 Ground 焊盘 

本节将学习: 

y 高亮 power 网络和 pins 

y 设置选项 

y 连接 power 走线 

y 建立 ground 焊盘过孔扇出 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_9.pcb 文件。 

高亮 power 网络和 pins 
 

菜单 View > Nets 

1. 在 View List 区域，选择 PWR 网络 

2. 在 Color by Net 区域，选择一个亮紫色 

3. 点击 OK 按钮 

设置选项 
 

为了更容易定位走线和过孔，我们对走线格点和其他选项做一些设置。 

提示: 状态栏将显示相关设置信息 

设置选项: 

1. 输入无模命令 g0 设置工作格点为 0 

2. 输入无模命令 gv.05 设置过孔格点为 0.05 

3. 输入无模命令 ad 设置角度模式为 45 度角模式 

4. 输入无模命令 e 设置结束为过孔模式，请注意状态栏显示的当前状态 

连接 power 走线 
 

菜单 Setup > Display Colors 
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1. 设置 Die Side 的 traces 颜色为黑色 

2. 点击 OK 按钮关闭对话框 

3. 在 BGA 工具条上，点击 Add Route 按钮 

4. 使用无模命令的搜索命令，输入 s bga1.v4 按回车键后，再按空格键开始走线 

5. 点击鼠标右键选择 Width 

6. 在弹出的无模命令对话框中输入 0.4 并按回车键 

Power 连接: 

 
7. 移动鼠标走线到如上图所示的电源环上 

8. 使用 Ctrl+click 以过孔结束模式结束于电源环上 

9. 重复以上的步骤，将所有的 PWR 焊盘连接到电源环上。因为设计是对称的，在走了

一些走线之后，你可以使用拷贝命令进行走线的拷贝。 

提示: 记住将 Die Side 的走线颜色设置回红色后才可视 

建立 ground 焊盘过孔扇出 
 

菜单 Setup > Display Colors 

1. 在 Design Items 区域，清除 Copper 列的选项勾，然后点击 OK 按钮 

2. 放大视图到球阵列的中间 

3. 在 BGA 工具条上，点击 Add Route 按钮 

4. 输入无模命令的搜索命令 s bga1.p10 按空格键后开始走线 

5. 点击鼠标右键选择 Width 

6. 输入 .4 并按回车键 
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GND connections: 

 
7. 进行如上图所示的走线 

8. 通过 Ctrl+click 以过孔结束走线 

9. 重复布线步骤扇出 GND 网络，你也可以通过拷贝命令进行操作 

10. 再次打开菜单 Setup 下的 Display Colors 对话框 

11. 恢复 Design Items 区域下的 Copper 勾选并按 OK 按钮 

12. 不要保存此设计 
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第十三节 建立灌铜区域 

本节我们将学习: 

y 更新设计规则和参数 

y 添加 GND 灌铜区域 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_10.pcb 文件。 

更新设计规则和参数 
 

菜单 Setup > Design Rules > Rules 对话框 > Default 按钮 > Default rules 对话框 > Clearance 按钮 

设置规则: 

1. 在 Clearance Rules 对话框，在 Clearance 区域，设置 Copper-Trace、Copper-
Via、Copper-Pad 和 Copper-SMD 为 0.2 

2. 点击 OK 按钮，关闭 Default Rules 和 Rules 对话框 

3. 在菜单 Tools 下，选择 Options 

4. 选择 Thermals 表格 

5. 在 Non-drilled Thermals 区域，选择 Flood Over 

6. 点击 Drafting 表格 

7. 在 Flood 区域，在 Min Hatch 区域框中输入 0.6 

8. 点击 OK 按钮 

添加 GND 灌铜区域 
 

Drafting 按钮   > Copper Pour 按钮   

添加 copper pour 

添加灌铜区域: 

1. 在菜单 View 下选择 Extents 以便浏览这个设计 

2. 确认当前层是 BGA Side 
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3. 点击鼠标右键选择 Rectangle 

4. 输入无模搜索命令 s bga1.ac1 按回车键并按空格键 

5. 再次输入无模搜索命令 s bga1.a23 按回车键并按空格键，这时将自动弹出 Add 
Drafting 对话框。 

指派铜皮网络 

指派网络 

1. 在对话框的 Net 区域，下拉选择 GND 

 
2. 点击 Apply 按钮应用此修改 

3. 在 Width 区域，输入 0.15 

4. 点击 Options 按钮 

5. 勾选 Flood Over Vias 选项框并点击 OK 按钮 
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6. 在弹出的 Proceed with Flood 信息框中点击 是 按钮 

 
7. 关闭 Add Drafting 对话框 

 
8. 不要保存此设计 
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第十四节 创建 Wire Bond 图 

一般来说对于高级封装设计中的基本要求是产生一个 wire bond 图，wire bond 图描述

了 die pads、wire bonds 和 substrate bond pads 的关系。另外，对于每个 BGA 焊

盘所连接的 wire bond 名字。本节将介绍在设计中通过 wire bond 图命令增加 BGA 焊

盘名标签。 

本节将学习: 

y 调节颜色设置 

y 创建 wire bond 图 

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_11.pcb 文件。 

调节颜色设置 
 

菜单 Setup > Display Colors 

为了演示 wire bond 图的效果，我们关闭与此无关的项目颜色 

调节颜色设置: 

1. 清除 Traces、Vias、Copper、Errors 和 Ref.Des. 列的颜色勾选框 

2. 清除 BGA Side 行的颜色勾选框 

3. 在 Selected Color 区域选择黑色 (与背景同色) ，然后在 Other 区域将 Connection
颜色设置为黑色 

4. 点击 OK 按钮关闭对话框 

创建 wire bond 图 
 

BGA 按钮   > Wire Bond Diagram 按钮   

我们使用 wire bond 图模式来定义产生 BGA 焊盘名标签的参数，可以应用这模式对于单

个焊盘或者元件上的所有焊盘 

开始命令: 

1. 按 Ctrl+B 浏览整个设计 

2. 放大显示 substrate bond pads 的第一行位置 
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3. 在没有选择任何目标的情况下，点击鼠标右键选择 Select Components 

4. 选择一个 substrate bond pads 

结果: Add BGA Pin Labels 对话框出现 

 

设置 wire bond 图参数 

在 Add BGA Pin Labels 对话框中对于这些 die pads 连接到多个 BGA pad 时，让你指

定增加哪一个 pad 标签 。你也可以设置增加的文本标签的尺寸和所在层 

指定参数和增加标签: 

1. 在 Size 框中输入 .12 指定文本的尺寸 

2. 在 Line Width 框中输入 .01 指定文本的线宽 

3. 点击 OK 按钮 

结果: 标签出现在每个 substrate bond pad 上 

旋转和移动文本标签 

Select 按钮   

添加了标签之后，你必须旋转和移动它们。 

标签位置: 
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1. 在没有选择目标的情况下，点击鼠标右键选择 Select Documentation 

2. 输入无模命令 g0 设置工作格点为 0 

3. 输入无模命令 dro 关闭设计规则检查 

4. 通过框选所有的 top 层的 BGA 标签 

5. 点击鼠标右键选择 Rotate 90 

结果: 所有的标签逆时针旋转 90 度 

6. 当所有的标签还处于被选中状态时，点击鼠标右键选择 Move，所有的标签黏附与鼠

标指针上动态地跟随鼠标移动 

7. 移动鼠标指针将其对应的标签放置与相应的 substrate bond pads 附近 

8. 重复这步骤，直到移动所有的标签到合适的位置 

 
9. 不要保存此设计 
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第十五节 创建 Wire Bond 报告 

通过 Basic script 功能可以创建两种不同的 Excel 格式报告文件： 

y BGA 管脚 (solder ball) 到 die 功能名称的报告  

y Die 功能名称到 BGA 管脚的报告  

输出的排序根据你选择的报告类型，报告完成连接性报告、校验和 die 功能名称与网络的

对应。 

本节将学习: 

y 创建一个 wire bond 报告 

提示: 如果你没有安装 Excel，报告将自动产生以文本文件格式的报告  

准备 

如果没有打开软件，请运行 PADS Layout，并打开\PADS Projects\Samples 路径下

的 PBGAtutorial_12.pcb 文件。 

创建一个 wire bond 报告 
 

菜单 Tools > Basic Scripts > Basic Scripts 

创建报告文件: 

1. 在 Basic Scripts 对话框中，选择 BGA Wirebond Report 并点击 Run 按钮 

结果: 一个对话框出现 

 
2. 选择 BGA Pin to Die Function Name Report 
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3. 勾选 Include Die Pin Numbers 

4. 点击 OK 按钮产生报告，出现提示信息 Depending on the complexity of your BGA 
design, this may take a moment or two appears 

 
5. 点击 OK 按钮继续，连接报告将产生并在 Excel 中打开，如下图所示 

die 功能报告: 

 
6. 浏览报告之后，你可以通过选择菜单 File 下的 Save As 保存此报告文件 

7. 在菜单 File 下，点击 Exit 退出 

8. 点击 Close 关闭 Basic Scripts 对话框 

9. 不要保存此设计 

 

恭喜您！您已经完成了此教程的学习！ 
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